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1 IO-Link Overview
IO-Link is an open standard serial communication protocol that allows for the bi-directional exchange of data from IO-Link-
supported devices, such as sensors, that are connected through IO-Link.
Advantages to an IO-Link system include standardized wiring, remote configuration, simple device replacement, advanced
diagnostics, and increased data availability. Because IO-Link is an open standard, the devices can be integrated in almost
any fieldbus or automation system.
An IO-Link system consists of an IO-Link master and an IO-Link device such as a sensor, lighting product, IO-Link hub, or
actuator.
The functions and parameters of the IO-Link devices are represented in a device description file (IODD). IODD files contain
information about identification, device parameters, process and diagnostic data, communication properties, and other
details. The IODD files for Banner IO-link devices can be downloaded for free on www.bannerengineering.com.

1.1 IO-Link Systems
At least one IO-Link master and one IO-Link device are required for IO-Link communication.
The IO-Link master and IO-Link device are connected using a 3-wire standard unshielded cable. The IO-Link master
establishes the connection between IO-Link device and the higher-level control system. An IO-Link master can have several
IO-Link ports, and only one IO-Link device can be connected to each port.
IO-Link hubs such as Banner's R90C-4B21-KQ or IO-link converters make it possible to integrate devices without an IO-Link
output in automation systems via IO-Link.

Figure 1. IO-Link map

1.2 Operating Modes
The operating mode can be configured for any port on the IO-Link master. The following modes can be used:

Deactivated
Use deactivated mode for any unused IO-link master ports if a device is not connected.
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IO-Link Manual
The IO-Link master only connects IO-Link devices that have a certain vendor ID and device ID (1: IOL_MANUAL).
This mode is also required to for the Backup and Restore or Restore function.

IO-Link Autostart
The IO-Link master connects to every connected IO-Link device (2: IOL_AUTOSTART).

Digital Input
The IO-Link port functions as a standard digital input (3: DI_C/Q).

Digital Output
The IO-Link port functions as a standard digital output (4: DO_C/Q).

1.3 Combining IO-Link Devices with Different Specifications
Any combination of masters and devices is possible. However, if IO-Link devices of a different IO-Link specification are
combined, note that:

• Only IO-Link v1.0 devices can be operated on the IO-Link v1.0 masters
• IO-Link v1.0 and v1.1 devices can be operated on the IO-Link v1.1 masters

IO-Link devices with IO-Link specification V1.0 do not support backup and restore features (data storage).
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2 DXMR90-4K Overview
Banner's DXMR90-4K IO-Link Master consolidates data from multiple sources to provide local data processing as well as
accessibility for host systems as a platform for the Industrial Internet of Things (IIoT).
The DXMR90-4K IO-Link Master can have multiple configurations. The DXMR90-4K will have a model number label on the
housing. Use the model number to identify which boards are included in the controller.
 

 
The DXMR90-4K contains four IO-link ports, allowing for concurrent communication to up to four IO-Link devices. Data is
collected into the internal logic controller to facilitate edge processing, protocol conversion to Industrial Ethernet, Modbus/
TCP, and pushing information to web servers. In addition to IO-Link devices, the IO-Link master can be used to transmit up
to eight discrete signals using pin 2 or pin 4 of the IO-link master ports.
The configurable IO-link master works with IO-link devices and allows for quick deployment of IO-link data to Ethernet/IP and
Modbus TCP, and Modbus RTU networks.

• Local control or connectivity with:
◦ Automation protocols including EtherNet/IP, Modbus/TCP, and Modbus RTU
◦ Internet protocols including RESTful API and MQTT with web services from AWS

• Logic processing and problem solving capable of deploying solutions to process and control data from multiple
devices

• Compact housing saves space and weight compared to traditional "block" style form factors
• IP67 housing simplifies installation in any location by eliminating the need for a control cabinet
• Consolidate cable runs to minimize cabling and associated weight, especially in weight critical applications such as

robotics
• Flexible and Customizable—Expanded internal logic controller with action rules and ScriptBasic programming
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Logic Controller
Program the DXMR90-4K's logic controller using action rules and/or ScriptBasic programming languages, which can
execute concurrently. The control functions allow freedom when creating custom sensing and control sequences.
The logic controller supports the Modbus protocol standards for data management, ensuring seamless integration
with existing automation systems. File password protection is an option.
Action Rules

• Thresholds (IF/THEN/ELSE) with timers, minimum on/off time
• Math/Logic Rules (arithmetic and bitwise operators)
• Control Logic (logical operators and SR/T/D/JK flip flops)
• Trending (multiple averaging filters)
• Tracking (counts, on/off times)
• Push data on conditions

Programming Language—ScriptBasic to create variables, arrays, functions, loops, IF/THEN/ELSE, logical and
arithmetic operators, API commands, register access, string functions and operators, time commands
Scheduler

• Time/calendar-based events
• Holiday skips
• One-time events
• Dynamic scheduler updating
• Astronomical clock

Push to the Cloud
Register Mapping

• Cyclical Read rules from wireless devices or local wired Modbus devices that include optional scaling, error
conditions, and the ability to activate a read rule

• Cyclical or Change of State Write rules to local wired Modbus devices with scaling
• Modbus/TCP Controller/Primary Read or Write rules for external devices on the network

Wired Connectivity
Ethernet: Modbus/TCP (client/server) or Ethernet/IP

User Interface
API Interface—Host Initiated control and Web service integration

2.1 Models
Model Ethernet Connection IO-Link Master Connections Other Connections

DXMR90-4K One female M12 D-Code Ethernet
Connector

Four female M12 connections for IO-
Link master connections

One male M12 (Port 0) for incoming power

2.2 Automation Procotols
The DXMR90-4K IO-Link Master supports the following automation protocols.

EtherNet/IP
By default, EtherNet/IP is enabled. Configure the DXMR90-4K Local Registers as EtherNet/IP input or output
registers using the DXM Configuration Software. A single register can only be set as either an EtherNet/IP input or
output register.
EtherNet/IP registers are limited to 228 read registers set as E/IP Originator to DXM and 228 write registers set as
DXM to Originator

Modbus RTU
Modbus RTU port (port 0) is used by a host system to access the DXMR90-4K as a slave device. The slave Modbus
RTU port allows access all the internal local registers concurrently with the master RTU port. Port 0 can be
configured as a Modbus Master Port using the DXM Configuration Software but is defined as a slave port by default.
Configure to a Master port using the DXM Cofiguration Software to allow for data access to other Modbus devices
like the 4-Port IO-Link to Modbus Master R90C-4K-MQ or other Modbus accessible slave devices.
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Modbus TCP/IP
A host system acting as a Modbus master (Client) can access the DXMR90-4K using the Modbus TCP/IP protocol
over Ethernet. Standard Modbus TCP port 502 is used by the DXMR90-4K for all Modbus TCP/IP requests.
All internal local registers are available to the host system concurrently with Modbus TCP.
By default, the DXMR90-4K is configured as a Modbus TCP/IP Server.

2.3 Dimensions
All measurements are listed in millimeters, unless noted otherwise.

Figure 2. DXMR90-4K dimensions

16 mm
[0.63”]

32.3 mm
[1.27”]

6x M12 x 1 (Female)

121.7 mm
[4.79”]

16.3 mm
[0.64”]

20 mm
[0.79”]

20 mm
[0.79”]

20 mm
[0.79”]

40 mm
[1.57”]

4.5 mm dia
[0.18”]

63.5 mm
[2.5”]

50.5 mm
[1.99”]

M12 x 1
(Male)

8 mm
[0.32”]

12.3 mm
[0.48”]

32.3 mm
[1.27”]
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3 Quick Start Guide

3.1 Apply Power to the Controller
Follow these instructions to apply 12–30 V DC power to the DXMR90-4K using a wall plug.
Required equipment:

• DXMR90-4K IO-Link Master
• PSW-24-1 Wall plug power supply; 24 V DC, 1 A (or equivalent 24 V DC M12 power supply)
1. Connect the PSW-24-1 power supply to the male M12 connector on the DXMR90-4K, Port 0.
2. Plug in the PSW-24-1 wall plug power supply.

3.1.1 Wiring
Figure 3. DXMR90-4K IO-Link Master ports

M12 Power Port/ 
Configurable Modbus Port 0
(male)

Configurable
Modbus

Port 0
(female)

D-coded Ethernet
(female)

IO-Link Master
Ports 1-4
(female)

Table 1: Ports 1-4 female connector

Port 1–4 5-pin M12 Connector (female) Pin Wire Color Description

2

3
4

1

5

1 Brown (bn) 18 V DC to 30 V DC

2 White (wh) I/Q (digital in-out)

3 Blue (bu) DC common (GND)

4 Black (bk) C/Q (communications/digital in-out)

5 Gray (gy) Not used/reserved

Table 2: Port 0 male connector

Port 0 4-pin M12 Connector (male) Pin Wire Color Description

1

4
3

2

1 Brown (bn) 18 V DC to 30 V DC

2 White (wh) RS485 / D1 / B / +

3 Blue (bu) DC common (GND)

4 Black (bk) RS485 / D0 / A / -

Table 3: Port 0 female connector

Port 0 4-pin M12 Connector (female) Pin Wire Color Description

2

34

1

1 Brown (bn) 18 V DC to 30 V DC

2 White (wh) RS485 / D1 / B / +

3 Blue (bu) DC common (GND)

4 Black (bk) RS485 / D0 / A / -
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Table 4: D-coded industrial Ethernet connector

4-pin Industrial Ethernet Connector
(female)

Pin Wire Color Description

1

4 3

2
1 Black (bk) +Tx

2 Red (rd) +Rx

3 Green (gn) –Tx

4 White (wh) –Rx

3.2 Configuration Instructions

3.2.1 DXM Configuration Software
Configure the DXMR90-4K using the configuration software. Use this software to customize your configuration and to
process data from the Controller.
Download the latest version of all configuration software from http://www.bannerengineering.com. For more information on
using the DXM Configuration Software, refer to the instruction manual (p/n 209933).

Figure 4. Overview of the configuration software features

Ethernet

DXM Configuration Software

Local Registers

Register 
View Utility

System
Settings

Register Mapping

Scheduler

Action Rules

Script Basic

XML Config File

The configuration software creates an XML file that is transferred to the DXM using an Ethernet connection. The DXM can
also receive the XML configuration file from a Web server using an Ethernet connection. This configuration file governs all
aspects of the DXM operation. The DXM Configuration Software allows the user to define parameters for the DXMR90-4K,
then saves the configuration in an XML file on the PC.
After the configuration file is saved, upload the XML configuration file to the DXMR90-4K for operation.

Important: The DXMR90-4K IO-Link Master comes preloaded with a default configuration XML file. You
can download the default XML on the product page for the DXMR90-4K.

This quick start guide outlines the basic operations to set up a DXMR90-4K using the configuration software. For a more
comprehensive explanation of features, refer to the DXM Configuration Software Instruction Manual (p/n 209933).
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3.2.2 Configuring the DXMR90-4K Controller
This section will walk you through the method of setting up the DXM Configuration Software and communicating with a
connected DXM device. Version 4 of the DXM Configuration Software supports multiple DXM device models, each of which
incorporates different features.
As soon as a DXM model is connected to your computer, the software automatically detects the correct model and loads the
appropriate screens. You may also manually select which model of DXM you are configuring if you intend to create a
configuration file without connecting a device. This ensures that the interface and the configuration file use the correct
features.
Not all screens are available for all models. To change to another model of DXM, go to the Select Mode screen and use the
drop-down list to select another model. If the active configuration is incompatible with the selected model, you will be
prompted to either proceed and wipe out the active configuration or cancel the model change and preserve the configuration.

Figure 5. Opening splash screen for Traditional Setup mode

When the Select DXM Model drop-down is set to DXMR90-4K, a new network discovery table is displayed. Click Scan
Network for DXMs to detect DXM devices on the host computer's network. Discovered DXMs are listed in the network
discovery table. Double-click any row entry to connect to that DXM. If the DXM's IP address is already known, the standard
TCP connection option is available below the network discovery table.
The default IP address of the DXMR90-4K is 192.168.0.1. To connect to the device, you need to be on the same subnet. You
can do this by accessing the control panel on your PC and accessing your Network Connections properties. It is important to
ensure that the adaptor you are connected to is within the 192.168.0.* subnet when you first connect to the DXMR90-4K IO-
link master.
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Figure 6. Windows Network Properties settings screen

Important: Any model of DXM may connect to the configuration software regardless of which device model
is selected in the configuration software. Compatibility is checked before configuration files are uploaded to
the device.

For more information on the device registers and port settings of the DXMR90-4K IO-Link Master, refer to the DXMR90-4K
IO-Link Master Device Register Map (p/n 229732).

Modify Multiple Registers
Modify a range of registers from the Local Registers > Local Registers in Use > Modify Multiple Registers screen.
Select which parameter fields to modify. Most parameters have three selections.

• Unchanged—no changes
• Default—change to default settings
• Set—modify parameter. Other selections will appear based on the parameter.

Figure 7. Modify Multiple Registers screen

1. Enter the Starting register and Ending register.
2. Select the value to change using the drop-down list next to each value.
3. Enter the new value in the field provided.
4. To push register values to the web server, set Cloud Permissions to read.
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If the Cloud Permissions are set to Read, the web server only views data from the device and cannot write data to
the device. If the permissions are set to Write, the web server only writes to the device and cannot read the data. If
the permissions are set to Read/Write, the web server can read the data from the device and write to the device from
the web.

5. Click Modify Registers to apply the changes.

Set the IP Address
Follow these instructions to change the DXMR90-4K's IP address.
By default, the DXMR90-4K is set to a static IP address of 192.168.0.1. The IP address can be changed by using the DXM
Configuration Software and updating the XML.

1. Launch the DXM Configuration Software.
2. Go to the Settings > Ethernet screen.
3. In the IP Address section, select Static IP or DHCP from the drop-down list.

• If Static IP is selected, enter the IP address, Subnet, and Gateway address as desired.
• If DHCP is selected, the IP address, Subnet, and Gateway address are grayed out and not configurable.

Changing the IP Address to DHCP can make it so the DXM cannot be reached. Before changing this to DHCP,
you MUST have a server that is going to assign an IP Address to the DXMR90-4K.

4. Save your changes to the configuration file (File > Save).
5. Upload the configuration file to your controller (DXM > Send Configuration to DXM).

Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the
device.
Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending
the XML file to the device to avoid losing data. If you select DXM > Send XML Configuration to DXM before saving the
configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

1. Save the XML configuration file to your hard drive by going to the File > Save As menu.
2. Go to the DXM > Send XML Configuration to DXM menu.

Figure 8. Status indicator bar

• If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in the
cable and reconnect the DXM to the software.

• If the Application Status indicator is green, the file upload is complete.
• If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.
After the file transfer is complete, the device reboots and begins running the new configuration.

3.3 Mechanical Installation
Install the DXMR90-4K to allow access for functional checks, maintenance, and service or replacement.
All mounting hardware is supplied by the user. Fasteners must be of sufficient strength to guard against breakage. Use of
permanent fasteners or locking hardware is recommended to prevent the loosening or displacement of the device. The
mounting hole (4.5 mm) in the DXMR90-4K accepts M4 (#8) hardware. See the figure below to help in determining the
minimum screw length.
 

NUT
3 mm *

for minimum 
engagement of 
three threads

Screw Length = 16.0 mm + “X” mm + 3 mm

X

 *

16.0 mm
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CAUTION: Do not overtighten the DXMR90-4K's mounting screw during installation. Overtightening can
affect the performance of the DXMR90-4K.
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4 Controller Connections
To connect IO-Link devices on machines in industrial environments, an M12 quick disconnect connection is typically used.
The pin assignment is according IEC 60974-5 is the following:

• Pin 1: 24 V DC
• Pin 2: Switching Digital I/O (PNP only)
• Pin 3: 0 V
• Pin 4: Switching Digital I/O (NPN, PNP, or Push-Pull) and IO-link Communication Line

Figure 9. IO-Link pin assignments

1

L+

C/Q

L-

3
2 4

IO-Link Mode (process data)

Digital I/O (DIO) Mode (ON/OFF data)

Figure 10. DXMR90-4K IO-Link Master ports

M12 Power Port/ 
Configurable Modbus Port 0
(male)

Configurable
Modbus

Port 0
(female)

D-coded Ethernet
(female)

IO-Link Master
Ports 1-4
(female)

One male M12 connection provides common power and ground to all M12 IO-Link ports. One 100 Mbps Ethernet port
(female) uses an M12 D-coded Ethernet connection.

• Modbus TCP
• EtherNet/IP
• Configuration/discovery port

Four IO-Link controller connections using female M12 connectors.
• Separate IO-Link control and programmability for each connection point
• Configurable SIO mode on Input 1 and Input 2 of each IO-Link port

The DXMR90-4K IO-Link Master has 4 Class A ports. Pin 2 on these is an additional discrete IO channel. For specific pinout
connections, see Wiring on page 8.
For more information on the device registers and port settings of the DXMR90-4K IO-Link Master, refer to the DXMR90-4K
IO-Link Master Device Register Map (p/n 229732).

4.1 Ethernet
Before applying power to the DXMR90-4K, verify the Ethernet cable is connected.
The Ethernet connection supports the DXM Configuration Software, Modbus/TCP, and EtherNet/IP. ScriptBasic also has
access to Ethernet for custom programming. Use the software to configure the characteristics of the Ethernet connection,
including the IP address. Any parameters not changeable from the menu system are configurable from the configuration
software.

4.2 Internal Local Registers (Slave ID 199)
The main storage elements for the DXMR90-4K are its Local Registers, which can store 4-byte values that result from
register mapping, action rules or ScriptBasic commands.
For more information on the device registers and port settings of the DXMR90-4K IO-Link Master, refer to the DXMR90-4K
IO-Link Master Device Register Map (p/n 229732).
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Local Registers updated from Modbus and Ethernet/IP transactions are restricted to a16-bit data value to follow standard
Modbus Holding Register definition.
The Local Registers defined in Action Rules must all be within the same register group. For example, an Action Rule cannot
have inputs from an integer group with the result register defined as a floating point register. To move between integers and
floats, use the Register Copy Rule.

Registers Description

12001-12845, 17001-19000 32-bit unsigned integer-based registers

12846-12850 Special function registers (can be reset registers)

12851-12900, 19001-20000 Non-volatile register with limited capability for permanent data storage

13001-17000 32-bit IEEE 754 floating point registers. Floating point values require two Local Registers to store a value.
Floating point Local Registers are referenced on the odd numbered register addresses: 13001, 13003, and
13005. When using Action Rules/Read Rules, always reference the odd numbered register addresses.

Local Registers 12001–12845, and 17001–19000 (Internal Processor Memory, 32-bit, Unsigned)—The Local Registers are
the main global pool of registers. Local Registers are used as basic storage registers and as the common data exchange
mechanism. External Modbus device registers can be read into the Local Registers or written from the Local Registers. The
DXMR90-4K, as a Modbus master device or a Modbus slave device, exchanges data using the Local Registers. Modbus
over Ethernet (Modbus/TCP) uses the Local Registers as the accessible register data.
Local Registers 12846–12850 (Reset, Unsigned)—These Local registers are reserved for use as Reset registers. A time
interval can be specified in the configuration software for the DXM to reset. If the data in the register does not change within
the user-specified time interval, the DXM resets.
Local Registers 12851–12900 and 19001–20000 (Data Flash, Non-volatile, 32-bit, Unsigned)—The top 50 Local Registers
are special non-volatile registers. The registers can store constants or calibration type data that must be maintained when
power is turned off. This register data is stored in a data flash component that has a limited write capability of 100,000 cycles,
so these registers should not be used as common memory registers that change frequently.
Local Registers 13001–17000—These Local Registers are paired together to store a 32-bit IEEE floating point format
number in big endian format. Registers 12001 [31:16], 12002 [15:0] store the first floating point value; registers 12003, 12004
store the second floating point number. There are a total of 2000 floating point values; they are addressed as two 16-bit
pieces to accommodate the Modbus protocol. Use these registers when reading/writing external devices that require Modbus
registers in floating point format. Since Modbus transactions are 16-bits, the protocol requires two registers to form a 32-bit
floating point number.
Virtual Registers—The DXMR90-4K has a small pool of virtual registers that show internal variables of the main processor.
Some register values will be dependent upon the configuration settings of the DXMR90-4K. Do not use Read Rules to move
Virtual Local Registers data into Local Registers. Use the Action Rule > Register Copy function to move Virtual Local
Registers into Local Registers space (12001–12850).
Table 5: Modbus registers for virtual registers

Registers Definition

22001 GPS latitude direction (N, S, E, W)

GPS Coordinate Data if the DXM is configured to read an external GPS unit.
22002 GPS latitude

22003 GPS longitude direction (N, S, E, W)

22004 GPS longitude

22015–22016 Reboot cause (Restart Codes above) Reboot Type

22017–22018 Watchdog reset count Counter to track how many resets have been caused by the Watchdog

22025–22026 Http Push SSL Acquires
Statistical counts of connections, disconnections and forced disconnects when
the DXMR90-4K creates a connection using SSL/TLS (Encrypted connections)

22027–22028 Http Push SSL Releases

22029–22030 Http Push SSL Forced Releases

22031–22032 Http Push Attempts
Statistical counts of connections, disconnections and forced disconnects when
the DXM controller creates a connection using HTTP non-encrypted

22033–22034 Http Push Successes

22035–22036 Http Push Failures
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Registers Definition

22037–22038 Http Push Last Status

Last DXMR90-4K push status

0 = Initial state, no push attempt as finished yet
1 = Attempt complete
2 = Attempt aborted

22055–22056 Alarms, smtp, attempts Email attempts

22057–22058 Alarms, smtp, fails Email failures

22100 Number of read maps in default

Read Map statistics

22101 Number of read map successes

22102 Number of read map timeouts

22103 Number of read map errors

22104 Read map success streak

22105 Number of write map successes

Write Map statistics
22106 Number of write map timeouts

22107 Number of write map errors

22108 Write map success streak

22109 Number of passthrough successes

API message passing statistics
22110 Number of passthrough timeouts

22111 Number of passthrough errors

22112 Passthrough success streak

23000 Read map success count

Read/Write maps statistics

24000 Write map success count

25000 Read map timeout count

25000 Write map timeout count

27000 Read map error count

28000 Write map error count

29000 Read map success streak

30000 Write map success streak

31000 Read map is in default

TCP Client Stats—The "x" represents the socket 0 through 2. The flex socket is not used. This range repeats for the next
socket.
Table 6: TCP client statistics

Register Definition

2x001 Socket x connection attempts (20001 is the first socket, 21001 is the second socket...)

2x003 Socket x connections

2x005 Socket x disconnections

2x007 Socket x transmits

2x009 Socket x receives

2x011 Socket x resolver attempts (reserved)

2x013 Socket x resolvers (reserved)

2x015–2x020 Reserved

2x021 Socket x Rule 0 transmits
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Register Definition

2x023 Socket x Rule 0 receives

2x025 Socket x Rule 0 timeouts

2x027 Socket x Rule 0 broadcasts

2x029 Reserved

2x031 Socket x Rule 1 transmits

2x033 Socket x Rule 1 receives

2x035 Socket x Rule 1 timeouts

2x037 Socket x Rule 1 broadcasts

2x039 Reserved

Reset Codes—The reset codes are in virtual register 11015 and define the condition of the last restart operation.
Table 7: Reset codes

Reset Code Definition

0 Undefined

1 Unknown

2 General

3 Brownout

4 Watchdog

5 User

6 Software

7 Return from backup mode

4.3 Connecting to Remote IO-Link Devices
The DXMR90-4K has four IO-link ports for connecting IO-Link devices and digital sensors, lights, and actuators. All ports use
a 4-pin M12 female connector to connect to remote devices. No additional wiring is required if the sensors use compatible
wiring.
Table 8: Ports 1-4 female connector

Port 1–4 5-pin M12 Connector (female) Pin Wire Color Description

2

3
4

1

5

1 Brown (bn) 18 V DC to 30 V DC

2 White (wh) I/Q (digital in-out)

3 Blue (bu) DC common (GND)

4 Black (bk) C/Q (communications/digital in-out)

5 Gray (gy) Not used/reserved

The basic communications parameters for the IO-Link ports are set in the DXM Configuration Software and are saved in the
XML configuration file. Each port can have unique settings.
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Figure 11. RTU Configuration screen for ports 1-4

The DXM Configuration has a special tab for configuring the port settings on the IO-link master. To access go Register
Mapping--> IO-link Configuration. In this section you can configure the port settings of the IO-link Master.
The operating mode can be configured for any port on the IO-Link master. The following modes can be used:

Deactivated
Use deactivated mode for any unused IO-link master ports if a device is not connected.

IO-Link Manual
The IO-Link master only connects IO-Link devices that have a certain vendor ID and device ID (1: IOL_MANUAL).
This mode is also required to for the Backup and Restore or Restore function.

IO-Link Autostart
The IO-Link master connects to every connected IO-Link device (2: IOL_AUTOSTART).

Digital Input
The IO-Link port functions as a standard digital input (3: DI_C/Q).

Digital Output
The IO-Link port functions as a standard digital output (4: DO_C/Q).

For more information on the port settings of the DXMR90-4K IO-Link Master, refer to the DXMR90-4K IO-Link Master Device
Register Map (p/n 209933).

4.3.1 Replacing an IO-Link Device During Operation (Backup/Restore
Mode)
Replacing an IO-Link device during operation is common, and inadvertent changes to device settings can cause operational
problems and down-times. Operating personnel without special knowledge or tools can replace IO-Link devices quickly and
without errors.
When the backup function of the IO-Link master is used, the IO-Link master automatically provides the saved parameters to
the new device after replacement. This makes IO-Link device replacement seamless in IO-Link applications. Another
common industry term for this function is data storage mode.
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. Backup+Restore Mode
If a port on the IO-Link master is set to Backup+Restore, then the new device added to the IO-Link port takes in the
same device configuration as the device that was just replaced, as the IO-Link master had stored the last
configuration change by a backup (3: Type compatible Device V1.1, Backup + Restore).

. Restore
If the port on the IO-Link master port is set to Restore, then the new device takes in the configuration according the
settings saved in the master at the time of the last backup. Because possible configuration changes were not saved
in the master, a different behavior from the previous one before the replacement may occur (4: Type compatible
Device V1.1, Restore).

4.4 Configuring Connected Banner IO-Link Devices
Banner's IO-Link Configuration Software offers an easy way to configure Banner IO-Link masters and Banner IO-Link
devices, offering users control of master and device configuration.
The easy-to-use software provides a variety of tools and works with the DXMR90-4K, R90C-4K-MQ, and R45C-2K-MQ IO-
Link Masters. Configure Banner IO-link Masters and IO-Link devices using the free IO-Link Configuration Software, available
for download on the product page for the DXMR90-4K at: https://www.bannerengineering.com/us/en/products/part.
813874.html.
Like the DXM Configuration Software, this software enables you to configure port settings for the DXMR90-4K. It also has the
ability to configure Banner IO-link Devices connected to the DXMR90-4K.
For instructions on how to use the software to configure IO-link port settings and IO-link devices connected to the IO-link
master, use the IO-Link Configuration Software Instruction Manual, available from the software by going to Help > Help File.
The IO-link Configuration Software Instruction manual can also be downloaded directly on the product page for the
DXMR90-4K.

4.5 Connecting to Remote Modbus Devices
In addition to the 4 IO-link ports, the DXMR90-4K has one Modbus Master Port, the female M12 port uses a 4-pin M12
female connector to connect to remote devices. No additional wiring is required if the sensors use compatible wiring.
Table 9: Port 0 female connector

Port 0 4-pin M12 Connector (female) Pin Wire Color Description

2

34

1

1 Brown (bn) 18 V DC to 30 V DC

2 White (wh) RS485 / D1 / B / +

3 Blue (bu) DC common (GND)

4 Black (bk) RS485 / D0 / A / -

The DXMR90-4K can be a Modbus RTU master device to other slave devices and can be a Modbus slave device to another
Modbus RTU master. The DXMR90-4K uses female port 0 as a Modbus RTU master port to control external slave devices.
All wired devices connected to the master RS-485 port must be slave devices.

• As a Modbus RTU master device, the DXMR90-4K controls external slaves connected to female M12 port 0
• As a Modbus RTU slave device, the DXMR90-4K local registers can be read from or written to by another Modbus

RTU master device via port 0.
The Modbus RTU slave connection, port 0, is controlled by another Modbus master device that is not the DXMR90-4K. The
slave port is used by an external Modbus master device that will access the DXMR90-4K as a Modbus slave Device. Use the
DXM Configuration Software to define the operational settings for both the Modbus RTU master port 0 and the Modbus RTU
slave port 0.
The basic communications parameters for the RS-485 ports are set in the DXM Configuration Software and are saved in the
XML configuration file.

4.5.1 Define an RTU Read Rule
Follow these steps to create a new read rule.
This example creates a read rule to read six registers (address 1 through 6), from Port 0 Modbus Slave 4. The results are
stored in the Local Registers 12001 through 12006.
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Figure 12. System settings

1. Go to Settings > System to define the port settings to be compatible with the connected devices.
a) Verify the Baud rate and Parity match that of the connected Modbus slave devices.
b) The timeout controls how long the DXMR90 waits before determining a command has failed to send. Set the

timeout based on your specific application requirements.
c) The Delay between messages defines the minimum wait time between resending another command. Set the

delay based on your specific application requirements.
The Baud rate is defined for both the Modbus master and slave; settings include 19200 (default), 1200, 2400, 9600,
38400, 57600, and 115200. The Delay between messages applies to the Modbus master port and sets the
minimum wait time from the end of a Modbus transaction to the beginning of the next Modbus transaction. Parity is
defined for both the Modbus master and slave; settings include None (default), odd, even, space, and mark. Timeout
applies to the Modbus master port and covers the expected time for messages to be sent throughout the wireless
network. For the DXM, the Timeout parameter is the maximum amount of time the DXM should wait after a request is
sent until the response message is received from the Modbus slave device.

2. From the Register Mapping > RTU > RTU Read screen, click Add Read Rule.
3. Click the arrow next to the name to display the parameters.
4. Name your rule.
5. Select the slave ID.
6. Select how many registers to read, and the beginning register.
7. Define the register type, how often to read the register, and any other appropriate parameters.
8. If necessary, select the error condition. For this example, if the read function fails after three attempts, the read rule

writes 12345 to the DXM local registers. Notice the list of local register names this read rule is using.

Example Read Rules Configuration

Figure 13. Example Read Rules configuration settings
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5 Configuration Instructions

5.1 Set the Controller to use Authentication
The DXMR90-4K can be configured to send login and password credentials for every HTTP packet sent to the webserver.
This provides another layer of security for the webserver data.
Configuration requires both the webserver and the DXMR90-4K to be given the same credentials for the login and password.
The webserver authentication username and password are not stored in the XML configuration file and must be stored in the
DXMR90-4K.

1. From within the DXM Configuration Software, go to the Settings > Cloud Services screen.
2. In the upper right, select Show advanced settings.
3. Define the username and password in the Web Server Authentication section of the screen.

Figure 14. Web Server Authentication screen

The first time you select Require Authentication, a pop-up box appears with additional instructions. Since the data
is not stored in the XML configuration file, it is hidden from view of the DXM Configuration Software.

4. Click on Send Authentication.
The controller must be connected to the PC for this operation to succeed.
The data transmits directly to the DXMR90-4K's non-volatile memory. If successful, a pop-up window appears, asking
to reboot the device.

5. Select Yes to reboot the device.

5.1.1 Set the Web Services to Use Authentication
1. At the Banner Cloud Data Services website, go to Settings > Sites.
2. To edit the site settings, click Edit on the line of the site name.

Figure 15. Settings > Sites screen of the Banner CDS website

At the bottom of the pop-up window is a checkbox to enable authentication/validation.
3. Enter the same username and password as used in the DXM Configuration Software. The username and password

do not need to be a defined user within the Banner Cloud Data Services website.
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5.1.2 Controller Configuration Authentication
The DXMR90-4K can be programmed to allow changes to the configuration files only with proper authentication by setting up
a password on the Settings > Administration screen in the DXM Configuration Software.
With the DXMR90-4K connected to the PC, click Get Device Status. The DXMR90-4K status displays next to the button.

Figure 16. Settings > Administration screen

Use the DXM Configuration Software to:
• Set the Admin Password
• Change the Admin Password
• Remove the Admin Password

To change or remove an admin password, the current password must be supplied. The DXMR90-4K must be connected to
the PC to change the administration password.

5.2 Register Flow and Configuration
The DXMR90-4K register data flow goes through the Local Registers, which are data storage elements that reside within the
processor. Using the configuration software, the controller can be programmed to move register data from the Local Register
pool to remote devices or the I/O base.

Figure 17. Register flow

 

Remote DevicesEthernet

Processor Local
Registers I/O Base

5.2.1 Basic Approach to Configuration
When programming an application in the DXMR90-4K, first plan the overall data structure of the Local Registers. The Local
Registers are the main storage elements in the DXMR90-4K. Everything goes into or out of the Local Registers.

1. In the DXM Configuration Software, name the Local Registers to provide the beginning structure of the application.
2. Configure the read/write rules to move the data. The Read/Write rules are simple rules that move data between

devices (Nodes, Modbus slaves, sensors, etc) and the Local Registers.
3. Most applications require the ability to manipulate the Local Register data, not just move data around. Use the Action

rules to make decisions or transform the data after the data is in the Local Registers. Action rules can apply many
different functions to the Local Register data, including conditional statements, math operations, copy operations, or
trending.

4. To perform scheduled events in Local Registers, go to the Scheduler screen in the DXM Configuration Software.
These rules provide the ability to create register events by days of the week. The scheduler can also create events
based on sunrise or sunset.
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5.2.2 Troubleshooting a Configuration
View Local Registers using the Local Registers > Local Registers in Use screen of the configuration software.
When a configuration is running on the DXMR90-4K, viewing the Local Registers can help you to understand the
application's operation. This utility can also access data from remote devices and the LED registers.

5.2.3 Saving and Loading Configuration Files
The DXM Configuration Software saves its configuration information in a XML file. Use the File menu to Save or Load
configuration files.
Save the configuration file before attempting to upload the configuration to the DXMR90-4K. The DXM Configuration
Software uploads the configuration file saved on the PC to the DXMR90-4K; it will not send the configuration loaded in the
tool.

5.2.4 Uploading or Downloading Configuration Files
The DXMR90-4K requires a XML configuration file to become operational. To upload or download configuration files, connect
a computer to the DXMR90-4K using the Ethernet port. Then use the Upload Configuration to Device or Download
Configuration from Device under the Device menu.

5.3 EtherNet/IP™ Configuration
The DXMR90-4K can be configured to send/receive local register data to and from an EtherNet/IP™ 1 host. EDS (Electronic
Data Sheet) files allow users of the EtherNet/IP protocol to easily add a Banner DXM device to the PLC. Download the EDS
files from the Banner website.

• DXM EDS Configuration File (for PLCs) (p/n b_4205242)
• DXM EIP Config File for DXM Controller with Internal Gateway (Models: DXM1xx-BxR1, DXM1xx-BxR3, and

DXM1xx-BxCxR1) (p/n 194730)

5.3.1 Configuring the Host PLC
On the host PLC, install the DXMR90-4K using an EDS file or by using the following parameters:

• Assembly1: Originator to DXM = Instance 112, 456 bytes (228 words)
• Assembly2: DXM to Originator = Instance 100, 456 bytes (228 words)

The Originator is the host PLC system, and the DXM is the DXMR90-4K. The host system sees the DXMR90-4K as a
generic device with the product name of Banner DXM (ProdType: 43 - Generic Device, ProdName: Banner DXM, Integer
Type - INT).

Important: Do not set the Requested Packet Interval (RPI) any faster than 150 ms.

5.3.2 Configuring the Controller
Use the configuration software to define the Protocol conversion for each local register to be EIP Originator > DXM or EIP
DXM > Originator from the Edit Register or Modify Multiple Register screens.
Define a DXM local register as EIP Originator > DXM when the host PLC (Originator) will send data to the DXMR90-4K local
register (DXM).
Define a DXM local register as EIP DXM > Originator when that register data will be sent from the DXMR90-4K (DXM) to the
host PLC (Originator).
Data from an EIP controller in assembly instance 112 is data destined for the DXMR90-4K local registers. The PLC is
normally configured for INT or UINT data transfer. This allows for a seamless transfer of data.

EIP Assembly Instance 112 (16-bit) DXM Local Registers

Adrs Data Adrs Data

0 1122 1 1122

1 3344 2 3344

2 5566 3 5566

1 EttherNet/IP is a trademark of Rockwell Automation.
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EIP Assembly Instance 112 (16-bit) DXM Local Registers

3 7788 4 7788

4 9900 5 9900

Data from the DXMR90-4K local registers is sent to the EIP controller using assembly instance 100. Each local register in the
DXMR90-4K defined as EIP DXM > Originator is collected in numerical order and placed into the data buffer destined for
assembly instance 100. DXM local registers are capable of 32-bits, but only the lower 2-bytes (16-bits) for each local register
are transferred.

EIP Assembly Instance 100 (16-bit) DXM Local Registers

Adrs Data Adrs Data

0 1122 11 1122

1 3344 12 3344

2 5566 13 5566

3 7788 14 7788

4 9900 15 9900

5.4 Commissioning and Connecting IO-Link Devices to a Rockwell
PLC with Eithernet/IP
An Add-On-Instruction or AOI is a feature introduced by Rockwell Software in version 16 of RSLogix 5000 programming
software. An AOI enables a user to develop and package PLC code in user-defined instructions that is reused throughout
their program.
Banner has developed three types of IO-Link related Add On Instruction (AOI) files for use with the Logix Designer software
package from Rockwell Automation.
Process Data AOIs (v2)—These files can be used alone, without the need for any other IO-Link AOIs. The job of a Process
Data AOI is to intelligently parse out the Process Data word(s) into separate pieces of information. All that is required to
make use of this AOI is an EtherNet/IP connection to the IO-Link Master and knowledge of where the Process Data registers
are located for each port.
Parameter Data AOIs (v2.1)—These files require using an associated IO-Link Master AOI. The job of a Parameter Data
AOI, when working in conjunction with the IO-Link Master AOI, is to provide quasi-realtime read/write access to all IO-Link
parameter data in the sensor. Each Parameter Data AOI is specific to a given sensor.
IO-Link Master AOIs (v2.1)—These files require the use of one or more associated Parameter Data AOIs. The job of an IO-
Link Master AOI is to translate the desired IO-Link read/write requests, made by the Parameter Data AOI, into the format a
specific IO-Link Master requires. Each IO-Link Master AOI is custom made for a given brand of IO-Link Master. Add and
configure the relevant Banner IO-Link Master AOI in your ladder logic program first; then add and configure Banner IO-Link
Device AOIs as desired, linking them to the Master AOI as shown in the relevant AOI documentation.
Instructions for using the DXMR90-4K AOI can be found on the DXMR90-4K product page on the Banner website.

5.5 Push Retries
Ethernet—The DXMR90-4K can be configured to send register data packets to a webserver. When the Ethernet
communications path is not operating, the DXMR90-4K retries the send procedure. With an Ethernet-based network
connection, the DXMR90-4K retries a message five times. The five retry attempts immediately follow each other. After all
attempts are exhausted, the register data packet is lost. At the next scheduled time, the DXMR90-4K attempts to send only
the new data. Any past data that the DXMR90 was unable to push is lost and cannot be recovered. Using SSL on Ethernet
will have no retries.
Event/Action—Event-based pushes caused by Action rules sent using email follow the same process when failures occur,
based on the network connection.
Email—There are no retries for emails that fail to be sent from the DXMR90-4K.
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6 Accessories
4-Pin Threaded M12 Cordsets—Double Ended

Model Length Style Dimensions Pinout

MQDEC-401SS 0.31 m (1 ft)

Male Straight/
Female Straight

 

40 Typ.
[1.58"]

ø 14.5 [0.57"]
M12 x 1

44 Typ.
[1.73"]

ø 14.5 [0.57"]
M12 x 1

 

Female

2

34

1

Male

1

4
3

2

1 = Brown
2 = White
3 = Blue
4 = Black

MQDEC-403SS 0.91 m (2.99 ft)

MQDEC-406SS 1.83 m (6 ft)

MQDEC-412SS 3.66 m (12 ft)

MQDEC-420SS 6.10 m (20 ft)

MQDEC-430SS 9.14 m (30.2 ft)

MQDEC-450SS 15.2 m (49.9 ft)

MQDEC-403RS 0.91 m (2.99 ft)

Male Right-Angle/
Female Straight

44 Typ.
[1.73"]

ø 14.5 [0.57"]

M12 x 1

32 Typ.
[1.26"]

30 Typ.
[1.18"]

ø 14.5 [0.57"]
M12 x 1

MQDEC-406RS 1.83 m (6 ft)

MQDEC-412RS 3.66 m (12 ft)

MQDEC-420RS 6.10 m (20 ft)

MQDEC-430RS 9.14 m (30.2 ft)

MQDEC-450RS 15.2 m (49.9 ft)

MQDEC-403RR 0.9 m (2.9 ft)

Male Right-Angle/
Female Right-

Angle

32 Typ.
[1.26"]

30 Typ.
[1.18"]

ø 14.5 [0.57"]
M12 x 1

31 Typ.

32 Typ.

MQDEC-406RR 1.8 m (5.9 ft)

MQDEC-412RR 3.6 m (11.8 ft)

MQDEC-420RR 6.1 m (20 ft)

5-Pin Threaded M12 Cordsets—Single Ended

Model Length Style Dimensions Pinout (Female)

MQDC1-501.5 0.5 m (1.5 ft)

Straight

44 Typ.

ø 14.5
M12 x 1

 

2

3
4

1

5

 

1 = Brown
2 = White
3 = Blue
4 = Black
5 = Gray

MQDC1-503 0.9 m (2.9 ft)

MQDC1-506 2 m (6.5 ft)

MQDC1-515 5 m (16.4 ft)

MQDC1-530 9 m (29.5 ft)

MQDC1-560 18 m (59 ft)

MQDC1-506RA 2 m (6.5 ft)

Right-Angle

 

32 Typ.
[1.26"]

30 Typ.
[1.18"]

ø 14.5 [0.57"]
M12 x 1

 

MQDC1-515RA 5 m (16.4 ft)

MQDC1-530RA 9 m (29.5 ft)

MQDC1-560RA 19 m (62.3 ft)

  DXMR90-4K IO-Link Master

 www.bannerengineering.com - Tel: + 1 888 373 6767 25



4-pin M12 D-code to RJ45 Shielded Ethernet

Model Length Style Dimensions Pinout (Male)

STP-M12D-406 1.83 m (6 ft)

Straight 47.4 Typ.

ø 14.5
M12 x 1.0 - 6g

RJ45

 

 
1 = White/
Orange
2 = Orange
3 = White/
Blue
6 = Blue

 

4

2

3

1

 
1 = White/
Orange
2 = White/
Blue
3 = Orange
4 = Blue

STP-M12D-415 4.57 m (15 ft)

STP-M12D-430 9.14 m (30 ft)

SMBR90S
• Stainless steel bracket
• 4x M4-07 pemnuts (B)
• Includes 2x M4 stainless

steel hex head screws
and flat washers

Hole center spacing: A = 40, B =
20
Hole size: A = ø 5

A

B

74

10.1
24

8.6

Power Supplies
PSD-24-4—DC Power Supply, Desktop style, 3.9 A, 24 V DC, Class 2, 4-pin M12/Euro-style quick disconnect (QD)
PSDINP-24-06—DC power supply, 0.63 Amps, 24 V DC, with DIN Rail Mount, Class I Division 2 (Groups A, B, C, D)
Rated
PSDINP-24-13 —DC power supply, 1.3 Amps, 24 V DC, with DIN Rail Mount, Class I Division 2 (Groups A, B, C, D)
Rated
PSDINP-24-25 — DC power supply, 2.5 Amps, 24 V DC, with DIN Rail Mount, Class I Division 2 (Groups A, B, C, D)
Rated
PSW-24-1—DC power supply with multi-blade wall plug, 100–240 V AC 50/60 Hz input, 24 V DC 1 A output, UL Listed
Class 2, 4-pin female M12 connector
PSWB-24-1—DC power supply with multi-blade wall plug,100–240 V AC 50/60 Hz input, 24 V DC 1 A output, UL Listed
Class 2, barrel jack connector
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7 Product Support and Maintenance

7.1 Specifications
Supply Voltage

12 V DC to 30 V DC
Supply Protection Circuitry

Protected against reverse polarity and transient voltages
Power Consumption

24 V DC at 100 mA + 200 mA/port = 900 mA maximum
Construction

Connector Body: PVC translucent black

Indicators
Green/amber: Program status indicators
Green/amber: Ethernet communications
Red/green/blue on port 1: IO-Link Port 1 Status
Red/green/blue on port 2: IO-Link Port 2 Status
Red/green/blue on port 3: IO-Link Port 3 Status
Red/green/blue on port 4: IO-Link Port 4 Status

Connections
Five integral 5-pin M12 female quick disconnect
One integral 4-pin M12 male quick disconnect
One integral 5-pin M12 female D-Code quick disconnect

Application Note
When connecting external devices through the DXMR90-4K, it is
important not to exceed maximum current limitations of 3.5 Amps

Communication Protocols
Modbus® RTU, Modbus/TCP, EtherNet/IP™ 2

Communication Hardware (RS-485)
Interface: 2-wire half-duplex RS-485
Baud rates: 1.2K, 2.4K, 9.6k, 19.2k (default), 38.4k, 57.6K, or 115.2K
Data format: 8 data bits, no parity, 1 stop bit

Security Protocols
TLS, SSL, HTTPS

Digital Inputs (SIO [DI] Mode)
Input Current: 5 mA typical
ON Voltage/Current: 15 V DC minimum/5 mA minimum
OFF Voltage: 5 V DC maximum

Digital Outputs (SIO [DO] Mode)
On-Resistance: 120 mΩ typical, 250 mΩ maximum
Current Limit: 0.7 A minimum, 1.0 A typical, 1.3 A maximum
Off Leakage Current: -10 μA minimum, 10 μA maximum

IO-Link Baud Rates
COM1: 4.8 kbps
COM2: 38.4 kbps
COM3: 230.4 kbps

Environmental Ratings
For Indoor Use Only
IP65, IP67, NEMA 1, UL Type 1

Operating Conditions
–40 °C to +70 °C (–40 °F to +158 °F)
90% at +70 °C maximum relative humidity (non-condensing)

Storage Temperature
–40 °C to +80 °C (–40 °F to +176 °F)

Vibration and Mechanical Shock
Meets IEC 60068-2-6 requirements (Vibration: 10 Hz to 55 Hz, 1.0 mm
amplitude, 5 minutes sweep, 30 minutes dwell)
Meets IEC 60068-2-27 requirements (Shock: 30G 11 ms duration, half
sine wave)

Required Overcurrent Protection

WARNING: Electrical connections must be
made by qualified personnel in accordance
with local and national electrical codes and
regulations.

Overcurrent protection is required to be provided by end product
application per the supplied table.
Overcurrent protection may be provided with external fusing or via
Current Limiting, Class 2 Power Supply.
Supply wiring leads < 24 AWG shall not be spliced.
For additional product support, go to www.bannerengineering.com.

Supply Wiring (AWG) Required Overcurrent Protection (Amps)

20 5.0

22 3.0

24 2.0

26 1.0

28 0.8

30 0.5

7.2 File System and Archive Process
The DXM file system is in a serial EEPROM that stores non-volatile configuration information. The serial EEPROM stores
basic data that is required to be non-volatile, including network configuration data, IP address, MAC address, network masks,
firewall settings, and authentication information.
The controller XML configuration file created by the DXM Configuration Software is stored in EEPROM. The small section of
non-volatile local registers is also stored in EEPROM.

2 EtherNet/IP™ is a trademark of ODVA, Inc. Modbus® is a registered trademark of Schneider Electric USA, Inc. PROFINET® is a registered trademark of PROFIBUS Nutzerorganisation
e.V.
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7.3 Update Your DXM Processor Firmware Using the Configuration
Software
To update your processor firmware using the DXM Configuration Software, follow these instructions.

1. Using the DXM Configuration Software version 4 or later, connect to the DXMR90-4K via Ethernet.
File loads to the DXMR90-4K will take about 8 minutes using USB or approximately 2 minutes using Ethernet.

2. On the DXM Configuration Software, go to Settings > General > Device Information to verify the current firmware
version.
You must load a different version with the same firmware number for the boot loader to operate. Download firmware
files from the Banner website.

Figure 18. Example Device Information screen; every device's information will be different

3. Under Settings > Reprogram, click Select upgrade file to select the firmware file to program.
After the file load is completed, the DXMR90-4K restarts and loads the new firmware file. It takes about 2 minutes to
complete the programming process. The device reboots when finished. Verify the firmware has been updated, under
Settings > General > Device Information.

7.4 DXMR90-4K Support Policy
The DXM Wireless Controllers are industrial wireless controllers that facilitate Industrial Internet of Things (IIoT) applications.
As a communications gateway, it interfaces local serial ports, local I/O ports, and local ISM radio devices to the Internet using
either a cellular connection or a wired Ethernet network connection. In a continuing effort to provide the best operation for the
DXMR90-4K, stay connected with Banner Engineering Corp to hear about the latest updates through the Banner website.
Create a login today to stay informed of all Banner product releases.

7.4.1 Firmware Updates
The DXMR90-4K has been designed to be a robust and secure IOT device. To provide the most reliable and secure device
possible, periodic firmware updates are released to enhance and expand the capabilities of the DXMR90-4K. Firmware
updates and description details are found on the Banner website. Customers with critical update requirements will get access
to pre-released firmware from the factory.

7.4.2 Website Information
The Banner website is the main method of disseminating DXMR90-4K information to customers. The data found on the
website include:

• DXM instruction manuals
• Configuration manuals
• Firmware downloads
• Firmware release notes
• Errata data, any known issues with a release of firmware
• Possible work-around solutions for known issues
• DXM Solutions Guides

7.4.3 Feature Requests
Our customer is our most valuable resource to improve our DXMR90-4K. If you have suggestions for improvements to the
DXMR90-4K or configuration tools, please contact Banner Engineering Corp.
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7.4.4 Potential DXM Issues
Potential issues with the DXMR90-4K are collected from Banner's support engineers to provide solutions. Users can get help
from the website documentation or by calling Banner Engineering for support help. Solutions are as simple as configuration
adjustments, work-around configuration solutions, or potential new firmware updates.

7.4.5 DXM Security
The DXMR90-4K was designed to collect local wireless sensor data, local sensor data, provide simple control, and send the
data to the cloud.
The DXMR90-4K does not run a Linux or Windows based operating system but an embedded real-time operating system
(RTOS) environment. As a proprietary operating system, the security aspects are easier to manage and minimize.
Security updates are released through the Banner Engineering Corp website (www.bannerengineering.com) and New
Product Release Announcements (NPRA).

7.5 Contact Us
Banner Engineering Corp. headquarters is located at:

9714 Tenth Avenue North
Minneapolis, MN 55441, USA
Phone: + 1 888 373 6767

For worldwide locations and local representatives, visit www.bannerengineering.com.

7.6 Warnings
Install and properly ground a qualified surge suppressor when installing a remote antenna system. Remote antenna
configurations installed without surge suppressors invalidate the manufacturer's warranty. Keep the ground wire as short as
possible and make all ground connections to a single-point ground system to ensure no ground loops are created. No surge
suppressor can absorb all lightning strikes; do not touch the Sure Cross® device or any equipment connected to the Sure
Cross device during a thunderstorm.
Exporting Sure Cross® Radios. It is our intent to fully comply with all national and regional regulations regarding radio
frequency emissions. Customers who want to re-export this product to a country other than that to which it was sold
must ensure the device is approved in the destination country. The Sure Cross wireless products were certified for use
in these countries using the antenna that ships with the product. When using other antennas, verify you are not exceeding
the transmit power levels allowed by local governing agencies. This device has been designed to operate with the antennas
listed on Banner Engineering’s website and having a maximum gain of 9 dBm. Antennas not included in this list or having a
gain greater that 9 dBm are strictly prohibited for use with this device. The required antenna impedance is 50 ohms. To
reduce potential radio interference to other users, the antenna type and its gain should be so chosen such that the equivalent
isotropically radiated power (EIRP) is not more than that permitted for successful communication. Consult with Banner
Engineering Corp. if the destination country is not on this list.

Important: Please download the complete DXMR90-4K IO-Link Master technical documentation, available
in multiple languages, from www.bannerengineering.com for details on the proper use, applications,
Warnings, and installation instructions of this device.

Important: Por favor descargue desde www.bannerengineering.com toda la documentación técnica de los
DXMR90-4K IO-Link Master, disponibles en múltiples idiomas, para detalles del uso adecuado,
aplicaciones, advertencias, y las instrucciones de instalación de estos dispositivos.

Important: Veuillez télécharger la documentation technique complète des DXMR90-4K IO-Link Master sur
notre site www.bannerengineering.com pour les détails sur leur utilisation correcte, les applications, les
notes de sécurité et les instructions de montage.

WARNING:
• Do not use this device for personnel protection
• Using this device for personnel protection could result in serious injury or death.
• This device does not include the self-checking redundant circuitry necessary to allow its use in

personnel safety applications. A device failure or malfunction can cause either an energized (on)
or de-energized (off) output condition.
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Important:
• Never operate a 1 Watt radio without connecting an antenna
• Operating 1 Watt radios without an antenna connected will damage the radio circuitry.
• To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure

Cross MultiHop (1 Watt) radio without an antenna connected.

Important:
• Electrostatic discharge (ESD) sensitive device
• ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
• Use proper handling procedures to prevent ESD damage. Proper handling procedures include

leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; and
assembling units on a grounded, static-dissipative surface.

7.7 Banner Engineering Corp Limited Warranty
Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following
the date of shipment. Banner Engineering Corp. will repair or replace, free of charge, any product of its manufacture which, at
the time it is returned to the factory, is found to have been defective during the warranty period. This warranty does not cover
damage or liability for misuse, abuse, or the improper application or installation of the Banner product.
THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR
IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF PERFORMANCE, COURSE OF DEALING
OR TRADE USAGE.
This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO
EVENT SHALL BANNER ENGINEERING CORP. BE LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR
ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY INCIDENTAL, CONSEQUENTIAL OR
SPECIAL DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE
PRODUCT, WHETHER ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE,
OR OTHERWISE.
Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any
obligations or liabilities relating to any product previously manufactured by Banner Engineering Corp. Any misuse, abuse, or
improper application or installation of this product or use of the product for personal protection applications when the product
is identified as not intended for such purposes will void the product warranty. Any modifications to this product without prior
express approval by Banner Engineering Corp will void the product warranties. All specifications published in this document
are subject to change; Banner reserves the right to modify product specifications or update documentation at any time.
Specifications and product information in English supersede that which is provided in any other language. For the most
recent version of any documentation, refer to: www.bannerengineering.com.
For patent information, see www.bannerengineering.com/patents.
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